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   1. Accessing the Graduate School Internet Portal Service `

YONSEI UNIVERSITY GRADUATE SCHOOL  

■ Accessing the Graduate School Internet Portal Service (http://portal.yonsei.ac.kr) 
    [Login will be available on the date of selecting miscellaneous fee(s). Refer to Page 4.]

1. Go to http://portal.yonsei.ac.kr. Move the cursor to "Academic Information System". Click on 
"Academic Management System (Degree Programs)".

  
2. Type in student ID and Password
   (Initial password is the 6 digits of birthdate in YYMMDD order)
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   2. Printing Admission Certificate
YONSEI UNIVERSITY GRADUATE SCHOOL  

■ Log in to Graduate School Internet Portal Service (http://portal.yonsei.ac.kr) 
   Click on '학적 (Student Record Management)' menu on left side of the screen -> Click on '증명' 

-> On the screen below click '출력'
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   3. Tuition Payment Guidelines `

YONSEI UNIVERSITY GRADUATE SCHOOL  

I. Tuition Payment

 1. Tuition Payment Process

   (Please note that the payment deadline differs depending on your nationality.)

What To Do
Dates and Notes

Korean Students Foreign Students

Select Miscellaneous 
Fee(s) to Pay

2022. 2. 7.(Mon) 09:30 
~ 2. 8.(Tue) 16:00

2022. 1. 5.(Wed) 09:30 
~ 1. 6.(Thu) 16:00 

↓

￭ Please mark ✓ for a miscellaneous fee(s) you wish to pay at Yonsei 
Portal Site (http://portal.yonsei.ac.kr), which is possible only during the 
period stated above. The payment will be made along with the tuition 
fee during the tuition payment period. 

Print Tuition Invoice
2022. 2. 9.(Wed) 09:30

~ 2. 11.(Fri) 16:00
2022. 1. 7.(Fri) 09:30 
~ 1. 13.(Thu) 16:00 

↓

￭ Go to http://portal.yonsei.ac.kr/ → Click on "Tuition and Payment" 
located on the bottom of the page → Login by typing in ID and 
password → Click "Registration" → Click "Tuition Invoice Print" → Click 
Inquiry/Registration → Click "Print“

￭ You can print the invoice ONLY during the given period. 
  Also, you can NOT print the invoice after paying the tuition.

Pay Tuition Fee (and 
Miscellaneous Fee(s))

2022. 2. 9.(Wed) 09:30 
~ 2. 11.(Fri) 16:00

2022. 1. 7.(Fri) 09:30 
~ 1. 13.(Thu) 16:00 

￭ Failure to pay tuition and/or other fees during the above period 
will result to cancellation of admission. 

￭ Tuition can be paid via internet banking, phone banking, ATM transfer 
and teller transactions from all banks to a designated Woori Bank 
account.

￭ We recommend that you complete the payment by 16:00 on the last day 
before the bank closes in order to avoid any unexpected problems, 
such as transaction limit excess.

￭ Tuition Fee Table (reference) :
  http://www.yonsei.ac.kr/en_sc/admission/tuition.jsp
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 2. What is Miscellaneous Fees?

   A. Overview of Miscellaneous Fees

Item Amount(KRW)
Paid 

Semester
Related 

Association 
Contact

Graduate Student 
Association Fee 11,000 Every 

semester

Graduate School 
Student 

Association
02-2123-3671

·The association works to enhance the graduate students' welfare and 
rights. Its main activities include academic supports through special 
lectures, conferences and more, issuance of a newspaper and the design 
and distribution of student pocketbook.

http://www.gradyonsei.com/
Student Health 

Mutual-aid 
Association Fee

22,500 Every 
semester

Student Health 
Mutual-aid 
Association

Sinchon:
02-2123-3350,2

Wonju: 033-760-5430
·The association refunds a part of medical and medicine fees paid to any 
of local hospitals. Those who paid for this fee are also entitled to a 
discount at Yonsei University Health Service Center. 

https://healthma.yonsei.ac.kr/

Yonsei Coop 
Investment 5,000 1st semester

Yonsei 
University Coop 

Goods
02-2123-4038

·The Coop seeks to improve its unionists' welfare. It grants a Coop 
scholarship, provides part-time opportunities and pays dividends (if 
there's a surplus). The investment paid will be returned when the status 
as a unionist terminates.  

* Applicable only to the students in Sinchon Campus
https://www.yonseicoop.com/

   B. How to Select Miscellaneous Fees 
     Click "Registration" → Click "Print/Registration" → Click "Miscellaneous Fees Choice" → Click a 

miscellaneous fee(s) you wish to pay. 

   C. Note
     1) Selection and correction of miscellaneous fees is only possible during the designated 

period.
     2) During the designated period, you can correct the selection of miscellaneous fees after 

clicking 'Temporary Save'. However, no correction is possible after you click  'Print the 
Bill'. 

     3) Tuition Waivers and Scholarships do not appear on the menu of 'Miscellaneous Fees 
Choice'. Please go to the 'Browse/Registration' menu to check on them. 
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3. How to Pay Tuition

  A. Virtual account transfer
    1) Transfer the total amount to Woori Bank virtual account assigned on the tuition invoice. 
    2) Each student gets an individual virtual Woori Bank account number. When the students have 

transferred money to their virtual Woori Bank account, (even if the name of the remitter is 
different from the student’s name) the student will automatically be enrolled.

    3) The total amount should be transferred at once because if it is different from the amount of 
the bill, it will not be deposited. (Please check the transfer limitation at the bank before 
paying the tuition)

  B. Credit card payments 
    1) Credit card payments can only be made by Woori Bank credit cards 
       (No other company’s card, debit cards and corporate cards allowed). 
     ※ Payments can be made at nationwide Woori Bank branches or through the Woori Bank 

website (http://card.wooribank.com). You can call the Woori Bank customer service center 
at 1588-9955 for further information.

  C. Wire Transfer 
    1) If you are not able to pay tuition fee by any of methods stated above due to some 

conditions such as living abroad, please pay it by wire transfer.
    2) Since only one time payment is allowed, please consider the exchange rate and other 

charges for transferring the money. If the money transferred is more than the tuition fee, 
the rest will be refunded to your bank account registered at Yonsei Portal during your 1st 
semester. (See below 6. for the bank account number registration)

Bank Information
· Name of Bank(branch) : Woori Bank (Yonsei University branch)
· Recipient : Yonsei University
· Swift Code : HVBKKRSE (or HVBKKRSEXXX)
· Bank Address : 50 Yonsei-ro, Seodaemun-gu, Seoul 03722, Korea

D. Caution
  1) Please be careful not to expose your virtual account number to other people when paying 

the tuition so that it is not wrongly used for any other purpose.
  2) When paying tuition, it must be paid through an official financial institution and through a 

legal process to prevent involving any illegal case. 

 4. Entrance Fee Waiver

   A. Please refer to the table below for the eligibility. The tuition amount indicated on the  invoice 
reflects the waived amount and is the fee you must submit.  

      * Go to http://portal.yonsei.ac.kr/ → Click on "Tuition and Payment" located on the  bottom 
of the page → Login by typing in ID and password (ID: Your student number; Password: 6 
digit date of birth, YYMMDD) → Click "Registration" → Click   "Print/Registration" → Click 
"Browse/Registration" → Click "Print the Bill" and check  the amount of entrance fee on the 
pop-up invoice.

   B. Please contact the graduate school office(tel. 82-2-2123-3229) before you make a payment if 
you believe the invoice reflects the wrong amount. 
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5. Verification of Tuition Payment

  To verify your tuition payment, go to http://portal.yonsei.ac.kr/ → Click on "Tuition and  
Payment" located on the bottom of the page → Click "Registration" → Click "Print/Registration" → 
Click "Print Payment Verification"

6. Entering Personal Bank Information

  A. Please register your personal bank account number to Yonsei Portal website. Your bank  
information is necessary for granting scholarships, returning the tuition balance and more.

  B. In case the name registered at Portal site and the name of account holder are not exactly the 
same, you may not be able to enter your bank account number successfully. In that case, 
please send a copy of your bank book and your student ID card to the Graduate School office 
(ysgrad@yonsei.ac.kr). You can also visit the graduate school office (Stimson Hall 2F, Building 
No. 502).

  C. How to Register : Go to http://portal.yonsei.ac.kr/ → Click on "Tuition and Payment"  located 
on the bottom of the page → Log in by typing in ID and password (ID: Your  student number, 
Password: 6 digit date of birth, YYMMDD)→ Click "Student Record" → Click "Information" → 
Click "Personal Data" → Find 계좌정보 and Click "Modify" → Input your bank information → 
Click “저장” (Save).

Full Waiver Half Waiver
￭ For those who have been admitted as 

research program students at Yonsei 
University Graduate School(YUGS) or who 
have achieved Master's degree from YUGS 

AND 
advance to higher degree program at YUGS.

￭· For those who have graduated from or 
are enrolled at YUGS and enter into a 

different department of YUGS.

·￭ For those who have completed research 
program at or achieved Master's or 

Doctoral degree from any of professional 
and/or specialized graduate schools at 
Yonsei University and enter any one of 

department of YUGS
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Graduate School Tuition Fee Payment Guideline

1.  Go to portal.yonsei.ac.kr  → Click on "Tuition and Payment" located on the left hand of the 
page

2. Log In : Typing in ID and password (ID: Your student number, Password: 6 digits of date of 
birth, YYMMDD) 
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3. Select Miscellaneous Fees : Click "Registration" → Click "Print/Registration" → Click 
"Miscellaneous Fees Choice" → Click a miscellaneous fee(s) you wish to pay → Click 
"Miscellaneous Fee Confirm" 

4. Printing the Bill  : Click "Registration" → Click "Print/Registration" → Click "Print the bill“
- The tuition invoice cannot be printed after the tuition is paid. 
- Please print the invoice before paying the tuition.

5. Tuition Fee Payment: Tuition fee shown in the individually assigned virtual Woori Bank 
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account must be paid in one installment. 
   - Each student is given an individual Virtual Woori Bank account: When the students remit money to their 

virtual Woori Bank account, (even if the name of remitter is different from the relevant student’s name) 
the student will automatically be enrolled.  

6. Verification of Tuition Payment : Click "Registration" → Click "Print/Registration" → Click 
"Print Payment Verification"
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Caution: Overseas remittance

   

등록금 납부 시에는 적법한 절차로 공식 금융기관을 통하여 납부하여야 합니다. 

특히 외국인 학생들이 등록금 납부할 때에 정식 금융기관을 이용하지 않고 불법 사설 환전소를 
이용하는 경우, 혹은 지인을 통하여 환전 혹은 이체를 진행하는 경우에 그 과정에서 타인의 계
좌를 해킹하여 등록금 가상계좌가 보이스피싱에 도용되는 일이 발생하고 있습니다.

학생들은 등록금 납부 시 이러한 문제가 발생하지 않도록 적법한 절차로 공식 금용기관을 이용
하시기 바라며, 본인의 가상계좌번호가 타인에게 노출되지 않도록 유의하여 주시기 바랍니다. 

등록금 납부가 적법한 절차로 진행되지 않아 불법적인 사건에 연루되는 경우, 해당 등록금 납
부는 무효 처리(재등록을 하지 않을 시 제적)되며, 관련된 민·형사상 처벌을 받을 수 있으니 다
시 한 번 유의 바랍니다. 

When paying tuition, it must be paid through an official financial institution and 
through a legal process. 

Recently, there are some cases that students’ virtual accounts are used for voice 
phishing when students pay tuition through an illegal private currency exchange 
office or when they exchange or transfer money through an acquaintance, not 
through official financial institutions. 

Students should use official financial institutions in a legal manner to prevent such 
problems when paying tuition fees and be careful not to expose their virtual 
account numbers to others. 

If tuition payment is not carried out in a legitimate procedure and is involved in an 
illegal case, the tuition payment will be invalid (unregistered if you don't register 
again), and related civil and criminal penalties may be imposed.

缴纳学费时，请通过合法的途径和官方指定的方式进行缴纳。
近期发现有的学生通过非法的货币兑换方式实现学费缴纳，而不是通过官方指定银行或者金融机构
走正常的转账程序。这样学生缴纳学费的虚拟帐号很容易被利用成为网络诈骗的工具。
学生在缴纳学费时应通过官方指定的金融机构，杜绝此类情况出现。切记不要将虚拟账号透露给他
人。
未按合法程序缴纳学费并涉及违法行为的，缴纳的学费无效(如不重新注册，原有帐号会被取消)，
并会被追究法律责任。
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   4. Guidance for Student ID Card Issuance
YONSEI UNIVERSITY GRADUATE SCHOOL  

1. The student ID card is a multi-purpose identification card for Yonsei University 
   students. It is issued in collaboration with Woori Bank. It gives you access to university 

facilities such as libraries, sports facilities, computer rooms, etc. It also allows you to 
show electronically your attendance for classes. It can be used as a check card to pay 
at stationery stores, bookstores, and restaurants after opening a bank account at a 
campus Woori bank. Discounted price may be available at some stores on and off the 
campus if you show the card when purchasing. It can be also utilized as prepaid public 
transportation card in Korea after the cash charge in the campus ATMs. Please be 
aware that you can not get a refund for the amount left charged to your electronic    
currency if your ID card is lost or stolen.   

2. Eligibility: 2022 Spring Semester enrolled international students who consent to a 
   personal information collection, utilization, and processing entrustment to a trustee 

3. Application Period

4. How to find your student number

   Visit the Graduate School Website (http://graduate.yonsei.ac.kr/graduate_en/index.do)     
Check the Final Result of Fall 2021 Admissions  menu and type in your examinee’s       
number and your D.O.B. in YYMMDD order. 

5. How to Apply 

   Visit Yonsei Portal Service (https://portal.yonsei.ac.kr/main/indexe.jsp) → Log in with 
your student ID number and PW (initial PW : D.O.B. in YYMMDD order) → Academic 
Information System → Issue Student ID → Apply for an ID card → Agree with 
personal info. collection, utilization, and processing entrustment to a trustee → 
Check applicant’s information → 신청(Apply)

   ※ A photo file should be a JPG format with no more than 200KB. 
     
6. ID Pick-Up Period and Location (TBA)

    ※ Please visit the Bank with your passport or alien registration card to receive the ID 
card. 

7. Student ID Card with Check Card Function 

   If you want to use your Yonsei student ID card for cash deposit/withdrawal in ATMs, 
please take your alien registration card and a certificate of attendance to open  a 

Student Date Note

 International
   Students

 Feb. 26 (Sat), 2022 at 10 am ~
Please refer to updated information at 
https://www.yonsei.ac.kr/en_sc/suppo

rt/notice.jsp as of early Feb. 
2022.
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bank account to Woori bank on the campus. Please be advised that a certificate of  
attendance is available free of charge on the Online Transcripts & Certificates menu 
at Yonsei Portal Service or at the University Service Center with payment from 
March 2. 

   Foreign registration card may take a maximum of one month to receive from Korea 
Immigration Service. If you are under processing to issue an alien registration, you 
must wait for receiving the card.

8. Student ID Card Reissuance

   Visit Yonsei Portal Service (https://portal.yonsei.ac.kr/main/indexe.jsp) -> Log in with 
your student ID number and PW -> Academic Information System -> Issue Student 
ID -> Press Lost/Damaged/Expired Card Mgmt. button -> Lost/Damaged/Expired 
Card -> Registration -> Register -> ID Card Mgmt. -> Apply for an ID card -> 
Follow the application steps as above. It takes usually one week to obtain the card 
at the campus bank without charge. 

    - How to Report a Lost/damaged ID Card : Register at Yonsei Portal Service to prevent the 
lost/damaged ID card from being used again. Call the Woori bank customer service center 
immediately at 1588-9955 to stop its use if it is connected with your Woori Bank Account.

9. Cancellation of Lost/Damaged/Expired ID Card Report 

   Yonsei Portal Service -> Log in -> Academic Information System -> Issue Student ID ->  
Present Condition and Cancellation of the Lost/Damaged/Expired Card -> Report 
Cancellation.

 
10. Office Hours: Mon-Fri 9 am ~ 5:20 pm

11. Inquiries

   • University Service Center on Student ID Card: +822-2123-3200 (from overseas),
     02-2123-3200 (in Seoul)
   • Immigration Contact Center on Alien Registration Card: +82-1345 or +822-6908-1345 
     (from overseas), 1345 (in Seoul) 
   • Banking Service for international students at Woori Bank: +82-2-1599-2288 (from 
     overseas), 02-1599-2288 (in Seoul)
  . • Student ID Distribution at Sinchon Campus: Woori Bank: +82-2-313-3198 Ext. 313 or 
     321 (from overseas), 02-313-3198 Ext. 313 or 321 (in Seoul)
   .• Student ID Distribution at Songdo Campus: Woori Bank: +82-32-822-6321 (from 
     overseas), 032-822-6321 (in Seoul)
   • Student ID Distribution at Wonju Campus: Woori Bank: +82-33-760-5159 (from 
     overseas), 033-760-5159 (in Seoul)

UNIVERSITY SERVICE CENTER
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￭ You are required to register for courses via Yonsei portal (http://portal.yonsei.ac.kr) during the 
course registration period. This is not for the current semester, but for the upcoming semester.

￭ Under Article 21, Section 2 (Academic Probation) of the University Statutes and Regulations, 
students shall be placed on academic probation if their GPA falls below 2.0, and if they are on 
probation for two semesters in total, they will be academically dismissed. Students may be 
readmitted after dismissal, however, if they fail to meet the GPA requirement once again, they will 
not be able to apply for readmission. Please bear this in mind and enroll for your courses after 
full consideration. 

 
I. IMPORTANT INFORMATION

1. Registration Period for New or Current Students (Graduate and Supplementary Courses) 

     - 2022. 2. 14.(Mon.) - 2. 18.(Fri.) 
       * Online registration: 10:00 - 23:59   

2. Add/Drop Period (Graduate and Supplementary Courses)

     - 2022. 3. 4.(Fri.) - 3. 8.(Tue.)
       * Online registration: 3. 4.(Fri.) - 3. 7.(Mon.) 10:00 - 23:59
                             3. 8.(Tue.) 10:00 – 18:00

3. Course Selection

    A. Course Catalog and Syllabus
You can browse our course catalog and view syllabi on Yonsei Portal.

        http://portal.yonsei.ac.kr
        ￭ Main Portal Service → Course Catalog and Syllabus: Undergraduate & Graduate
        ￭ Academic Information System → Academic Management System → Course → Course 

Catalog 
          1) Changes to Courses: Changes made to the timetable during the registration period will 

be marked in blue. 
          2) Syllabus: Click on the purple arrow/note icon next to the course title to read the 

course syllabus.
    B. Credits
      1) How to check the number of credits you have earned 
        ￭ Go to Yonsei Portal (http://portal.yonsei.ac.kr) → Academic Information System → 

Academic Management System → Login → Student Record → Information → Grading 
Browse → Below the field heading “PSD (PASSED)“ is the total number of credits you have 
earned.

   5. Course Registration 
YONSEI UNIVERSITY GRADUATE SCHOOL  
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Degree
Minimum Number of Credits 

Required for Graduation
Minimum GPA Required 

for Graduation
Note 

Master's* 30 credits
3.0/4.3 (B0) or higher 

Minimum credit 
requirement for graduation 
may vary by departments.

Doctoral 30 credits
Joint 54 credits

       * : including students who have withdrawn from Joint Degree programs

        ※ Even though you register to audit a Major or credit course, it will count towards the 
number of credits you are allowed to take per semester. Those who are taking an 
additional semester will be charged for the extra credits. (For detailed information, please 
refer to “4. Important Notes”) 

        ※ Audited or supplementary courses with credits do NOT count towards the credit 
requirement for graduation.

      2) Directed Research Course (Non-credit) 
Under Article 2 of the Graduate School Thesis Regulations and Policies (submission 
requirements), students whose proposal has been accepted (or will be accepted in the 
upcoming semester) must enroll in Directed Research courses. 

     

Degree Regulations Course Title

Master's* After your proposal is approved, you should register for 
"Directed Research 1" course at least for one semester.

"Directed 
Research 1"

Doctoral/ 
Joint 

After your proposal is approved, you should register for 
"Directed Research 2" course at least for two semesters.

"Directed 
Research 2"

* : including students who have withdrawn from Joint Degree programs

    C. Retaking a course 
     1) Courses with the identical code are considered to be the same; if you take the same course 

twice, it will count as a “retake”. In this case, only one of them shall be credited. When 
you register for those courses, a notice will be given in a pop-up window.

        ※ You are allowed to retake a course once if you wish to achieve a better grade.   
     2) The above rule does not apply:
    ￭ if you register to “audit“ the course (on a Pass/Not pass basis)
         ￭ if the course is a "supplementary" course (Undergraduate) whose title is the same as that 

of Graduate School
 ￭ if different departments offer courses with the same title

     3) PhD students: if you register for the same course you took while doing your Master’s at 
Yonsei University Graduate School, it will NOT be considered as a retake. However, it 
might not fulfill requirements toward graduation, so please check with your department 
first.  

4. Important Notes

    A. Please make sure to select the right option for the type of course (eg. Major, Audit, 
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Research, Supplementary).
    B. Graduate students (Degree program) can register for a maximum of 12 credits per semester 

(including supplementary courses). 
      ￭ Non-degree students may take up to 6 credits per semester. They need to select the 

"Research" option for graduate courses and the "Audit" option for undergraduate courses.  
      ￭ Students MUST check the time schedules for Intensive or Field Training courses. 

Soon-to-be graduates and KGSP (Korean Government Scholarship Program) students are 
allowed to enroll for those courses only if they are required to graduate.   

      ￭ Students registering for the graduate school common course in Research Ethics must log 
into LearnUs website (http://learnus.org) to take the course. It opens on the first day of 
the semester and closes at 23:50 of the day (weekday) before the final exam period begins. 

    C. Please consult with your advisor or the head of the department before enrolling in courses. 
    D. Registration for Supplementary Courses
       1) Requirements for supplementary courses may vary among the departments; if you gained 

your previous degree in a different field of study than your current one, please contact 
your department before registration. The maximum number of credits you can take for 
supplementary courses is 12 in total.   

       2) You can register for supplementary courses via Yonsei Portal.
       3) You can choose to take those courses either on a supplementary (Graded) or an audit 

basis (Passed/Not Passed). They do not count towards the cumulative GPA or the credit 
requirement for graduation.           

    E. Registration for "Directed Research" Course
       1) Under the regulations set by the Graduate School Management Committee, since Spring 

semester 2003, Directed Research Course (I for Master’s candidates or those who have 
withdrawn from the Joint Degree program; II for Doctoral or Joint Degree candidates) has 
been automatically enrolled for students who are expected to graduate (Master’s and 
Doctoral candidates in their 4th or later semester; Joint Degree candidates in their 6th or 
later semester), Please check whether you are properly enrolled in the course during the 
registration period, and if your thesis proposal has not yet been accepted (or will not be 
in the following semester), you can delete it, 
※ If you meet your degree requirements earlier than your final semester, please submit 
the “Directed Research Registration Request Form” to the Graduate School Office during 
the course registration period in your third semester of Master’s* program, second 
semester of Doctoral program, fifth semester of Joint Degree program, respectively. 

         * : including students who have withdrawn from Joint Degree programs 

         (You need to contact your department to get the form and ask about the degree 
requirements.)          

       2) 12% of your tuition will be charged for an additional semester, provided that you only 
take the Directed Research course.  

    F. Your tuition fee for an extra semester (5th or later semester of Master's/Doctoral program; 
7th or later semester of Joint Program) will be charged according to the number of credits 
registered for. Please print your tuition invoice during the Additional Registration period.

       1) Tuition fees  
           ① 0 credit: 12% of tuition
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           ② 1-3 credits: 1/3 of tuition
           ③ 4-6 credits: 2/3 of tuition
           ④ 7 credits or more: full tuition
    G. You are required to take at least one course. If the course is canceled or you failed to get 

permission to take a supplementary course, please consult your department. Important 
notice about the course registration will be sent via email or text messages, so make sure to 
update your personal information on our portal (http://portal.yonsei.ac.kr) if there is any 
change. 

 ￭ Academic Information System → Academic Management System → Login → Student Record 
→ Information → Personal Data → Modify

    H. Credit Exchange Program (Cross-Registration) 
       1) You can enroll for courses in other specialized graduate schools of Yonsei University. 

You may take up to 6 credits per semester and 15 credits in total. Please note that the 
courses may NOT be audited. 

       2) Yonsei University Graduate School also has cross-registration agreements with other 
graduate schools in Korea. You may enroll in their courses as well; the courses may not 
be audited and credits will be awarded in accordance with the agreements with the host 
universities. 

       3) Under the agreement between three graduate schools located in Sinchon area, you can 
register for courses offered by Ewha Womans University or Sogang University via Yonsei 
Portal during the course registration period.  

          ￭ Choose “Ewha Womans university” or “Sogang University” in the list of departments. 
          ￭ The information about timetables and lecture rooms can be found on their websites.
            ① Ewha Womans University → Study Guideline→ Timetable/Syllabus → Graduate school
             (http://eureka.ewha.ac.kr/eureka/hs/sg/openHssg504024q.do?popupYn=Y&englishYn=Y)
            ② Sogang University → Graduate School → Information of Courses
             (http://sis109.sogang.ac.kr/sap/bc/webdynpro/sap/zcmw9016?sap-language=EN)
       ※ For the information about course registration in other graduate schools in Korea, please 

refer to the notice of our website (http://graduate.yonsei.ac.kr). If you wish to take courses 
at one of the universities, please submit the application form to the Graduate School Office 
before the deadline given in the notice. 

II. ONLINE COURSE REGISTRATION

 1. How to Register for Graduate Courses

   A. Go to Yonsei Portal (http://portal.yonsei.ac.kr) and click "Graduate Course Enrollment" on the 
Main Portal Service menu. (This service will be available from 10:00 am on the first day of 
the course registration period.)

   B. Login with your student ID and password (Default password: your date of birth in YYMMDD 
order). 

   C. Read the instructions carefully before you start. 
   D. Click on "Course Enrollment". The next page will show your department, major, and available 

courses. You can register for a course by clicking on its code which is in blue. The list of 
enrolled courses will appear at the bottom of the page. To cancel your registration, you need 
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to click on the code on the list. 

 2. How to Register for Supplementary Courses 

     (Refer to page 18-19 for detailed guidelines)
    A. Go to http://portal.yonsei.ac.kr → "Academic Information System" →"Academic Management 

System". 
    B. Login with your student ID and password (Default password: your date of birth in YYMMDD 

order). 
    C. Click “Course” on the left menu → “Undergraduate Supplementary Course” and read the 

notice carefully. 
    D. If you click on “Undergraduate Course Registration”, you can browse undergraduate courses. 

Select the program category, college and major first and then click “Browse” to check the 
list of courses available. You can request permission to take a course by clicking the note 
icon.   

    E. In order to view the status of your request, click “Result” on the left menu. 
    F. If you want to cancel your request, just click “X” button on the list of your supplementary 

courses. If you want to drop the course after the final approval is granted, you need to go 
to “Course” → “Course Enrollment” menu (graduate course) and click the blue course code 
on the list of your registered courses.  

    G. To see the final list of your supplementary courses (approved), go to “Course Enrollment” → 
Enrollment Status or “Graduate Course Enrollment”.

Ⅲ. IMPORTANT DATES 

    1. Course Withdrawal: 2022. 4. 4.(Mon.) - 4. 6.(Wed.) 
      ※ Withdrawn courses are marked W in the Transcript. 
      ※ Tuition is not refundable even in the case of course withdrawal
    2. Course Evaluation, Survey for Improvement of Research Environment &  

Graduate Programs: TBA

     3. Grade Confirmation & Request for Grade Change: TBA
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Supplementary Course Registration Guidelines 

1. General Information

  A. When you register for supplementary courses, you must comply with the regulations of 
your department. 

  B. No more than 12 credits, including supplementary courses, may be taken per semester.  
  C. The maximum number of credits allowed for supplementary courses is 12.     
  D. You should choose to take supplementary courses either on a supplementary (Graded; 

letter grade such as A+, B0 on the transcript) or an audit basis (Passed/Not Passed; P/NP 
on the transcript).

  E. Supplementary courses do not count towards the cumulative GPA or the credit requirement 
for graduation.   

2. Registration Period: Course Registration and Add/Drop Period 

  * Wonju Campus students can also enroll for courses via Yonsei Portal System

3. How to Register for Supplementary Courses

  A. Go to Yonsei Portal (http://portal.yonsei.ac.kr). Place the cursor on "Academic Information 
System" to click on "Academic Management System". 

  B. Login with your student ID and password (Default password: your date of birth in YYMMDD 
order).  

  C. Click “Course” on the left menu → “Undergraduate Supplementary Course” and read the 
notice carefully. 

  D. If you go to “Course Enrollment”, you can browse undergraduate courses. Select the 
program category, college and major first and then click “Browse” to check the list of 
courses available

* Please note that to register for Graduate courses you must go to “Graduate Course 
Enrollment” on the Main Portal Service menu. 
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 E. After selecting the course you wish to take and click the note icon . It will be added to 

the list of your enrolled courses at the bottom of the page. If you want to drop the course, 
click the icon   on the list again. 

 F. If you want to cancel your request, just click “X” button on the list of requested courses. If 
you want to drop the course after the final approval is granted, you need to go to the 
“Course Enrollment” menu and click the course code on the list of your registered courses.  

 G. Your request might not be approved either by your department or the Graduate School 
office for some reasons (e.g. regulations of the department, credit limit etc), so please make 
sure to check the status of your request – whether it is fully accepted or not - on Yonsei 
Portal. 

Approval Status Where to Drop Notes

 Request just submitted Undergraduate Supplementary 
Courses → Course Enrollment

You may not be able to drop 
courses while your request is 
pending approval
(To check the status of your 
request, click “Result” on the 
left menu)

Approved by the 
Department

Undergraduate Supplementary 
Courses → Course Enrollment

Approved by the 
Graduate School Office

Course → Course Enrollment → 
Enrollment Status
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   6. Library Guide
YONSEI UNIVERSITY GRADUATE SCHOOL  

1. Library Webpage: https://library.yonsei.ac.kr
Yonsei University Library holds about 2.3 million volumes and provides access to approximately 
17,000 print journals, 120,000 e-journals, 560,000 e-books, and 200 academic databases. For more 
details about library services such as Library Catalog, Research Guide, and Purchase Request, 
please refer to the library website above.

2. Library Hours

Type Name During Semester During Vacation
Mon. – Fri. Sat. Mon. – Fri. Sat.

Central 
Library

24 hour Study Room(1F) Opens 24 hours
Privileges Office(1F) 09:00-17:00 - 09:00-17:00 -

Humanities Collections: Books(2F)

09:00-21:00 09:00-15:00 09:00-20:00 09:00-15:00
Social Sciences & History 

Collections: Books(3F)
Science & Technology Collections: 

Books(4F)
Korean Classics Collection(5F) 09:00-17:00 - 09:00-17:00 -

Graduate Study Room(5F) 06:00-23:00
Study Room 1(6F) Opens 24 hours 06:00-23:00
Study Room 2(6F) 06:00-23:00 -

Yonsei- 
Samsung 
Library

Y-Valley/Y-Smart Space(1F) 08:00-23:00
Makerspace(1F) 09:00-17:30 - 09:00-17:30 -

Y-Scape(1F) 10:00-17:00 - 10:00-17:00 -
Information Commons(2F)

09:00-21:00 09:00-15:00 09:00-20:00 09:00-15:00Media Commons(3F)

Research Commons: 
Journals, References(5F)
Grand Study Room(4F) 08:00-23:00

Cafe(8F) 09:00-16:00 - 09:00-16:00 -

Branch 
Libraries

Law Library
(Yonsei-Samsung Library 6F) 09:00-21:00 09:00-15:00 09:00-20:00 09:00-15:00

Music Library
(College of Music, New Bldg. 2F) 09:00-17:30 - 09:00-17:30 -

Underwood Memorial Library
(International Campus) 08:30-24:00 09:00-18:00 09:00-18:00 -

 ※ For more details about library hours, please refer to the library website.

3. Temporary access before Yonsei student ID card issuance

New students can enter the Library with presentation of a tuition payment receipt and an ID 
card at the information desks of the Library. 
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   7. Yonsei Health Mutual-aid Association
YONSEI UNIVERSITY GRADUATE SCHOOL  

1. Website : https://healthma.yonsei.ac.kr

2. Office

   - Sinchon Campus Student Union Building Room 206 (☎ 02-2123-3350)
   - Mirae Campus Student Union Building Room 212-1 (☎ 033-760-5430)
3. Office Hour during Regular Semester : Mon-Fri 9:00-17:00 (Lunch 12:00-13:00)
4. Office Hour during Summer/Winter Breaks : Mon-Fri 9:00-15:00 (Lunch 12:00-13:00) 
5. Student Health Mutual-aid Association Qualification for Membership: 

  ￭ Only eligible for Yonsei University Graduate students who have paid Student Health Mutual-aid 
Association fee (KRW 22,500 per semester) for the semester. (Not applicable to family members)

6. How to Sign-Up

7. Semesters : Spring Semester : March 1 - end of August
Fall Semester   : September 1 - end of February (following year)

8. Period of Deduction 

   Treatment Receipts(medical expenses) for the semester will be accepted until the next semester.
   Please submit the receipt for medical expenses incurred at the beginning of the semester 20 

days after the start of the course.

Classification Period Object

Select 
Miscellaneous Fee

Tuition payment period

(Select Student Health 
Mutual-aid Association Fee)

• Graduate students 

Additional Sign-up 

Spring Semester : March
Fall Semester    : September 

( Non-refundable fees )
※ In this case,

 membership will activate 
from the day after sign-up 
till the end of the semester. 

• Students who did NOT pay for Mutual-aid    
  Association fee  during tuition payment      
  period
• Students on leave of absence
• Students who have applied for a full refund 
of tuition

※ Students who have applied for a full refund of tuition must sign up separately
 ( Excluding College of Medicine, Dentistry and Nursing, Wonju College of Medicine )

※ For detailed information will be noticed during additional sign-up period.
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9. Materials to Prepare and Method of Deductions Application

  ① Treatment (medical expenses) Original Receipt: Payment(Insurance), Record of the division of 
Non-Payment(No Insurance) format, Treatment Date and Treatment Dept. (Copies will not be 
accepted) 

  ② Student ID Card of Yonsei University (Statement of Enrollment) or your student ID number 
written down

  ③ Woori Bank Account Number of the Student (No need to copy account booklet – just record 
the account number)

  ④ consent to the Collection and Use of Personal Information(except for those who        
     submitted in advance)

Classification Campus Place

Register
by visiting Sinchon Sinchon Campus Student Union Building Rm. 206

Register
by 

Receipt box

Mirae
1. Mirae Campus Student Union Building Rm. 212-1
2. In front of the Student Association Office in Wonju College of 
Medicine

International General Education Hall Lobby

Register
by Mail Sinchon

Student Health Mutual-Aid Association
Rm. 206 Student Union Building, Yonsei University, 50 Yonsei-Ro, 
Seodaemun-ku, Seoul  (03722)

   * When the 4 items above are prepared, the medical expense deduction  application (by proxy) 
is possible anywhere regardless of affiliation at Sinchon, Wonju, or the International Campus.

  
10. Available Hospitals / Range of Available Deductions

   ￭ Available hospitals : Any hospital located in Korea (Oversea hospitals are excluded) 
   ￭ Range of Available Deductions : Limited to insurance payment of treatment expenses
     (Non-Insured Treatment and all the medicine costs that you purchase at the pharmacy and 

the Chinese medicine clinic are excluded)
   ￭ Limit : 1 million won with no division between treatment and hospitalization per semester

Treatment   Deducted Benefit Rate

Private Clinic Student Payment’s 50%

Hospital level Student Payment’s 40%

General Hospital Student Payment’s 30%

Special General Hospital Student Payment’s 20%

Health Service Center
90%

(100% of self-pay for some medical treatment 
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※ Non-Insured Treatment: National Health Insurance Corporation designated illnesses, delivery, 

non-life-threatening injuries or those not encumbering one’s job or daily life as items not 
covered by the standard insurance plan to limit financial issues and to maintain fairness of 
social insurance payments. Typical examples of non-insured medical treatment are 
orthodontia, plastic surgery for beauty treatment, surgery for eyesight correction, diet and 
skin care. For details on insurance payment/non-payment, please inquire at the hospital where 
you receive the treatment.

  ※ The deductions shall not exceed the actual insurance payment of one’s share. 

11. International Students

   Only international students who have signed up for the National Health Insurance in Korea can 
take the medical treatment fee deduction. Without the National Health Insurance, you can only 
receive support from Yonsei University Health Service Center.

and medicine)
Hospitalization Deducted Benefit Rate

Every Medical Institution Student Payment’s 30%
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1. Eligibility & Selection Process
 A. Eligibility (All of the following requirements should be met)
  ◼ 2022-Spring Semester Freshmen of Graduate School at Sinchon Campus
  ◼ Student whose parents’ residence is not Seoul, Student whose nationality is not Korea.

 B. Selection process: Online Application and Computerized Random Selection

 C. Note

   1) Students who are NOT required to submit additional documents

      - Students who major in law, dentistry, nursing

      - International students

   2) Students of Law Department can ONLY apply to the Beophyeon House.

   3) Students of Medicine College

     a. Students of Department of Medicine can ONLY apply to Chejung House (Tel: 02-2228-2700)

     b. Students of College of Dentistry and College of Nursing can ONLY apply to Muak #3

   4) Students at Mirae Campus are NOT allowed to apply for dormitories at Sinchon Campus.

   5) Making two applications for dormitories at Sinchon and Songdo Campus are NOT allowed.

   6) If you take a leave of absence during the semester, you MUST check-out the dormitory 

   7) Students who visit or live abroad can enter the dormitory after self-isolation for 10 days 

from the outside accommodation.

2. Dormitory Fee & Facilities

3. Application

 8. Application Guidelines for Muak Dormitory

YONSEI UNIVERSITY GRADUATE SCHOOL  

Dormitory Type Object
Dormitory 

Fee
Size(평)

Shower 

room & 

Bathroom

Facilities

Muak #2 Double Graduate Students (Female) TBA 4.09 Shared

Lounge, Main Dormitory Food 

Court, Store, Study room, 

Laundry room, Computer 

room, Prayer room, ATM

Muak #3 Double

 Graduate Students of the 
College of 

Dentistry and Nursing
(Male, Female)

″ 4.27 Shared

Community room, Laundry 

room, Study room, Computer 

zone, Gym, Chapel & Prayer 

room, Self kitchen, 

Convenience store, Self-Cafe

Muak #4 
Foreigners’ 

Building
(B-Wing 2~5F)

Single Foreigners
(Undergraduate & 

Graduate)

″ 6.4
Inside the 

room

Community room, Laundry 

room, Study room, Computer 

room, Gym, Self-kitchen, 

Convenience store

Double ″ 8.6
Inside the 

room

Single Handicapped students ″ 6.4
Inside the 

room

Single
Severely Handicapped 

students
(Parents accompanied)

″ 8.6
Inside the 

room

Beophyun House Double
Graduate Students of the 

department of law
(Male, Female)

″ 6.9
Inside the 

room

Convenience store, Cafe, 

Restaurant, Study room, Gym, 

Lounge, Laundry room, 

Self-kitchen, ATM
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   A. Period : Jan. 11(Tue) 10:00 ~ Jan. 12(Wed) 23:00, 2022

   B. How to apply : https://dorm.yonsei.ac.kr → Log in → On-line Application

4. 1st round selection announcement date: Jan. 18(Tue) 11:00, 2022

5. Required Documents

  ※ If you are a foreigner, you don’t need to submit the following documents.
   A. Submission period: 2022. 1. 18.(Tue) 10:00 ~ 1. 24.(Mon) 12:00 
   B. Submission process:  https://dorm.yonsei.ac.kr → on-line application → file submission
   C. Required Documents
      - Resident Registration Certificate
      - Family Relation Certificate
      - Resident Registration of Overseas Korean Certificate 
      - Certificate of Handicapped Person
   D. Note
      - Names of all family members and relations must be stated
      - Other numbers after 6 digits of birthdate must be blocked in the resident registration certificate. 
      - All the documents must be issued after Dec. 19th, 2021. 
      - Missing or false information may put you at a disadvantage in the process of evaluation.

6. Payment period : Feb. 3.(Thu) 10:00 ~ Feb. 5.(Sat), 2022

                                (If not paid in time, your application will be cancelled)

   - https://dorm.yonsei.ac.kr → my page → invoice → personal virtual account will be given

7. Health Inspection
The students selected as the residents must submit their health inspection (pectoral X gland) form, 

Corona virus check-up result, and the Certificate of Entry & Exit on their check-in date. If you avoid 

the health inspection or are found to be ineligible for community life, we will cancel your housing 

admission. 

8. Check-in date
  A. Check-in date: Feb. 28.(Mon) ~ Mar. 1.(Tue), 2022, 10:00 ~ 18:00

※ The schedules mentioned above might be changed(or cancelled) due to COVID-19

9. Contact Information 

  A. Muak and Woojungwon Dormitories: 02)2123-8419, 3622

  B. Beophyeon House: 02)2123-3617, 3693

  C. Email : muakdorm@yonsei.ac.kr

※ The schedules mentioned above might be changed due to the change of university’s academic 

calendar. Please visit the website(https://dorm.yonsei.ac.kr) and check updated notice at the end of 
Dec. 2021.

Housing Office

All notices regarding the operation of the International Campus Dormitory(Songdo Dormitory) for 
the 2022-1 semester will be announced through the Songdo Dormitory website
(https://yicdorm.yonsei.ac.kr) in mid-January.

Dormitory Management Team, International Campus
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D-2 유학생 비자(석사: D-2-3, 박사: D-2-4)를 발급할 예정인 학생들은 표준입학허가서(합격증과는 
다른 서류입니다. p.3 참조)를 신청해주시기 바랍니다. 다른 비자(A-1, A-3, D-1, D-5, D-9, E-1, 
E-7, F-1, F-6, H-2, 재외동포 비자 등)를 소지하여 입국 및 국내 체류에 문제가 없는 경우, 표준입
학허가서를 별도로 신청하실 필요 없습니다.

※ 유의 사항

  1. 국내에서 학부를 졸업하고 대학원에 진학하는 경우, 기존 비자는 만료됩니다. 

     연세대학교 일반대학원에서 발급한 표준입학허가서를 지참하여 신규 비자를 취득하시기 바랍니다. 

  2. 유학생 비자는 학적변동(휴학, 졸업, 제적 등) 발생 시 비자만료일과 상관없이 학적변동일 기준으로

     만료일자가 수정됩니다. 유학생은 학적변동일로부터 30 일 이내 출국해야합니다.

  3. 등록금을 납부하신 분에 한해 표준입학허가서를 발급해드릴 수 있습니다. 

      신입생 등록기간: 2022. 1. 7.(금) ~ 1. 13.(목)

“The Certificate of Admission”(which is different from the Certificate of Acceptance that 
can be printed out on the Yonsei Portal) is issued for students who will apply for a D-2 
visa (D-2-3: Master, D-2-4: Ph.D). If you hold any other visa(A-1, A-3, D-1, D-5, D-9, 
E-1, E-7, F-1, F-6, H-2, etc.) and can legally stay in Korea, then you don’t need to apply 
for it.

※ Attention 
1. If you finish undergraduate program in Korea your current D-2 visa will expire on the 
date of graduation. Please request for “The Certificate of Admission” and apply for a new 
D-2 visa.
2. In case of any change in the student’s status(taking a leave of absence, graduation, 
expulsion due to withdrawal or unregistered status, etc.), D-2 visa will expire. You must 
leave the country within 30 days from the date of change of the student’s status.
3. We can issue the certificate of admission only for those who have paid the tuition fee.
Registration period : 2022. 1. 7(Fri) ~ 1. 13. (Thu)

 9. Visa Issuance for International Students

YONSEI UNIVERSITY GRADUATE SCHOOL  
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비자 종류에 대한 자세한 사항은 링크를 통해 확인 하십시오.
https://www.visa.go.kr/openPage.do?MENU_ID=10102
Please refer to the following website for information about the various types of Korean 
visas.    
https://www.visa.go.kr/openPage.do?MENU_ID=10102

D-2 비자를 신청하실 분들은 등록금 납부를 완료하신 후 표준입학허가서를 신청해주시기 바랍니다.

여권사본, 사진파일(3.5x4.5cm, JPG),  재정증빙서류 원본, 최종학력 (아포스티유 혹은 영사확인) 서류

를 
ysgrad@yonsei.ac.kr (신촌캠퍼스 합격생)
choidy@yonsei.ac.kr (미래캠퍼스 합격생)
eung@yonsei.ac.kr (미래캠퍼스 원주의과대학 합격생)
으로 보내주시기 바랍니다. 표준입학허가서는 메일로 발송해드립니다. 

※ 유의사항 
재정증빙서류와 최종학력 서류는 반드시 원본서류가 제출되어야 표준입학허가서가 발행될 수 있습니
다. [외국인전형 최종합격자는 본 안내자료 32쪽을 반드시 확인바랍니다.]

After finishing the tuition fee payment, please provide us with a copy of your passport, a 

photo (3.5 x 4.5cm) in jpg format, and proof of funds(bank statement), Diploma (with 

Apostille or consular verification) 

ysgrad@yonsei.ac.kr [Sinchon(Seoul) Campus] 
choidy@yonsei.ac.kr [Mirae(Wonju) Campus]
eung@yonsei.ac.kr [Mirae(Wonju) Campus Medicine College]

We will send you the Certificate of Admission via e-mail.

※ Attention 
We can issue the certificate of admission only for those who have submitted the certified 
hard copy of the degree certificate & proof of funds. 
※ Those who accepted in the international students track : ’Certificate of Admission’ will be delivered 

for visa issuance after confirming the original documents for admission and confirming the full payment 

of tuition fees. (Refer to Page 3 from Application Guidelines for International students)
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1) 비자를 신청하실 분은 메일로 발송해드리는 표준입학허가서와 기타 필수 서류 지참하여 대사관(영
사관) 방문 및 비자 신청하시기 바랍니다. 

   With the Certificate of Admission and other required documents such as passport, 
application form, etc, please visit the nearest embassy in your country to apply for a D-2 
visa.

2) 한국에서 비자 연장 또는 변경 신청을 하실 분들은 서울남부출입국외국인사무소에 문의 후, 필요한 
제출서류와 함께 (예: 신청서) 여권, 표준입학허가서, 외국인등록증을 가지고 (예약 후) 방문하셔서 비
자 연장/변경 신청을 하시기 바랍니다. (http://www.hikorea.go.kr/pt/main_kr.pt 또는 대표번호 
1345) 

   If you want to extend or change your visa in Korea, please request it from the 
Southern Immigration Office (http://www.hikorea.go.kr/pt/main_kr.pt or just call 1345) 
about the detailed process or required documents. (eg. Application Form) We recommend 
you to visit the office after making a reservation. You will have to bring your passport, 
alien registration card, the Certificate of Admission, etc.

※ 유의사항:　표준입학허가서를 수령하신 후, 반드시 허가서에 나와 있는 정보가 본인의 정보와 일치하는지 
            확인하시고, 틀린 부분이 있을 경우 재발급 요청을 해주시기 바랍니다.
※ Attention
  Please check whether all the information written on the certificate of admission is correct.  
  If there is any mistake, please let us know.

입시원서를 제출할 때 일부 서류를 제출하신 것을 알고 있지만, 원활한 업무 진행을 위해 다시 한 번 
이메일로 제출 부탁드립니다. 

We are aware that you have already submitted some of the documents when you applied 
to our school, but please kindly send us the documents again via email so we can 
continue this process. 

Thanks in advance for your cooperation.
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3) 담당자 연락처 Contact information

연세대학교 일반대학원 교학팀 이효정
HyoJeong Lee
Office of Academic Affairs, Yonsei Gradaute School
Tel) 82-2-2123-3228, Email) ysgrad@yonsei.ac.kr 

원주캠퍼스 대학원 행정지원팀 최다연
Dayon Choi
Graduate School Office, Wonju Campus
Tel) 82-33-760-5032, Email) choidy@yonsei.ac.kr 

원주캠퍼스 의과대학 교학팀 신은경
Medicine College, Wonju Campus
Tel) 82-33-741-0215, Email) eung@yonsei.ac.kr

   10. Alien Registration and Insurance Policy 
YONSEI UNIVERSITY GRADUATE SCHOOL  

□ Immigration Services 
Call center: Dial 1345
HiKorea website: http://www.hikorea.go.kr – E-application

1. Application for Alien Registration Card 
   A. Students must apply for an alien registration card at a local immigration office within 90 days 

of arrival in Korea
   B. Required Documents
      - Application Form (available at the immigration office), passport, 1 color photograph (3.5 x 

4.5cm)
      - Certificate of Admission
      - Fee 30,000 KRW
   C. Immigration Office: Check your local immigration office and make sure you have prepared all
                          the required documents before you visit the office. We advise you to make 
                          a reservation (www.hikorea.go.kr) for the visit. 

       * Seoul(Sinchon) Campus : Southern Immigration Office
         Address : 151 Mokdongdong-ro, Yangcheon-gu, Seoul 
         Tel : 02-2650-6212
          Walking distance 10 minutes from the Mokdong station (line 5) and Omokgyo station (line 5)

2. Requirement for Other Activities 
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   A. International students with a D-2 (student) visa who wish to work part-time must acquire 
permission from the immigration office

   B. International students attending a graduate school are allowed to work a maximum of 30 
hours per week (Those of students whose TOPIK level is below 4 are only allowed half); a 
representative of school office must confirm the related documents (application form/business 
licence) before submission so please visit the Office of International Affairs (Baekyang Hall 
S302)

   C. International students who have changed work places must report of this change at the 
immigration office or via www.hikorea.go.kr

   D. Required Documents : Application form (available at the immigration office), passport, alien 
registration card, part time employment recommendation (applicable fees are waived for D-2 
(student) visa holders) 

3. Applying for an Extension of Length of Stay
   A. Application Period : From two months prior to the expiration date to the date of the 

expiration (Penalties are imposed when expiration dates are violated) 
   B. Required Documents : Application form (available at the immigration office), passport, alien 

registration card, application fee

4. Reporting Change of Residence 
   A. Registered aliens must report a change of residence at a local immigration office within 14 

days of the moving
   B. Required Documents: Application form (can be picked up from the immigration office), 

passport, alien registration card, document to prove residence
   C. Homepage: https://www.hikorea.go.kr/Main.pt

5. Reporting Changes in the Alien Registration Card 
   A. All important changes (passport, name, gender, birth date, nationality) must be reported to a 

local immigration office within 14 days of the change
   B. Required Documents : Application form (can be picked up from the immigration office), 

passport, alien registration card, document to prove change 

6. Re-Entry 
   A. All of the registered foreigners who want to re-enter South Korea after staying overseas must 

acquire a re-entry permit. (If you leave Korea without permission, then re-entry is restricted.)
   B. Required Documents : Passport, Alien registration card, Application Form
   C. How to apply: hikorea.go.kr
   D. Beginning Jan. 8, 2021, all foreigners arriving in South Korea must submit a COVID-19 PCR 

negative test result that has been examined within 72 hours prior to the date of departure to 
South Korea from their home country.

7. Taking a Leave of Absence : International students who seek to take a leave of absence from 
their current education program must apply for the leave of absence at their schools and must 
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depart Korea within 15 days of reporting. Alien registration cards must be returned to an 
immigration official at the airport at the time of departure. 

8. Returning to School 
   1) Students who wish to return to school must apply for the reinstatement on the Yonsei Portal 

website during the specified application period.
   2) Students must submit required documents to the graduate school office to acquire a new D-2 

visa. (Students who are from the countries where it takes a long time to process visa 
applications are advised to submit all of the required documents to the school at least two 
months before returning.)

▣ Guidelines for International Students Subscribing to National Health Insurance

1. All the international students are subject to the mandatory subscription to the National Health 
Insurance. National Health Insurance Service(NHIS) automatically processes the registration 
according to your alien registration date.  

2. Contributions payment: The contribution for the next month is due by the 25th of the current 
month(prepayment). NHIS sends a bill (by mail) around 10th of each month to the address (ARC 
registration address).
- payment method: automatic transfer, website, NHIS office, mobile application
- inquiry: Tel (1577-1000) / NHIS hompage (www.nhis.or.kr) / Mobile app (The건강보험, 모바일지로)

3. Insurance Benefits
- Various Benefits are available including dental and oriental medical treatment, health    
checkups, and pregnancy and childbirth-related medical expenses. Treatments for       diseases 
that do not affect work or daily life are not covered. (ex: plastic surgery)

4. Penalties for not paying the contribution
- Health Insurance Benefits at medical care institutions are unavailable
- Restriction on your visa extension

5. National Health Insurance Exclusion Application
- Please check with NHIS for detailed exception conditions
- Required documents: Documents verifying that medical guarantee is available



- 33 -

6. Inquiry
- Tel 1577-1000 , Dial 7 for foreign language service
- Tel 033-811-2000 Services in Foreign Languages (English, Chinese, Vietnamese, etc)
- Service hour: 09:00~18:00, weekdays

7. Please refer to the following link for more information
graduate.yonsei.ac.kr -> 학사안내 -> 학사안내 및 다운로드 -> 국제 – 7, 9번 안내사항 확인

▣ Guidelines for private insurance
To prepare for the accidents that cannot be covered by the National Health Insurance, 
our school provides additional private insurance. Students who stay in Korea with a D-2 
visa are provided with this insurance for the first two semesters.

Insruance affiliated with Yonsei University
http://n.foreignerdb.com/yonsei1
(ID: Student ID, password: 111111)
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   11. Submitting the original application documents 
YONSEI UNIVERSITY GRADUATE SCHOOL  

[ Guideline for those who accepted in the international students track ]

◯ ’Certificate of Admission’ will be delivered for visa issuance after confirming the original 
documents for admission and confirming the full payment of tuition fees.

◯ Application Guidelines for International Students (Page 3)
▣ Submitting the original application documents (Refer to the page 5~6 for details)

1. Those subject to Interview(including final acceptance only by document evaluation without 

interview) must submit all original application documents by mail or by visiting graduate 

school office from the date of notification of interview candidates till the start of the 

semester(‘Certificate of Admission’ will be delivered for visa issuance after confirming the 

original documents and confirming the full payment of tuition fees.)

2. Applicants from overseas universities shall submit a certificate of degree with Apostille or 

consular verification(Applicants with a degree from universities in China: submit a certificate 

by CDGDC or CHSI)

3. All the documents submitted are non-returnable. (However, if you bring the originals and 

photocopies to the graduate school office, the originals can be returned after checking 

them.)

◯ Visiting or Mailing Address

   

[Shinchon Campus / International Campus]

50 Yonsei-ro, Seodaemun-gu, Seoul 03722, Korea 

Graduate School Office (Stimson Hall 2F)

Tel: Seoul / International Campus : +82-2-2123-3229, 3233 

[Mirae Campus]

1 Yonseidae-gil, Wonju-si, Gangwon-do 26493, Korea

Yonsei University Mirae Campus, Mirae Hall (Room 135), Graduate School Office

Tel: Mirae(Wonju) Campus : +82-33-760-5032    
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   12. Education Verification Notice 
YONSEI UNIVERSITY GRADUATE SCHOOL  

Students who graduated from schools outside of Korea must submit their certificate of graduation and 

official transcript to the graduate school office in person during the following period. (returnable after 

the verification process) 

Submission Deadline: March 11th, 2022 (Office hour: 09:00 ~ 17:20, Mon~Fri)

※ All the documents submitted are non-returnable. (However, if you bring the originals and photocopies to 

the graduate school office, the originals can be returned after checking them.)

※ Those who accepted in the international students track : ’Certificate of Admission’ will be delivered 

for visa issuance after confirming the original documents for admission and confirming the full payment 

of tuition fees. (Refer to Page 3 from Application Guidelines for International students)

Please choose one of the following methods (for those students who have obtained their degrees in China, 

please refer to D.) If the submission is delayed due to any unavoidable circumstances, please contact the 

graduate school office in advance. 

(Building #502 Stimson Hall 2F, 02-2123-3229, ysgrad@yonsei.ac.kr) 

   ◆ Campus map link : https://www.yonsei.ac.kr/sc/intro/guide.jsp#XXX

A. Degree certificate verified by Apostille

B. Degree certificate verified by the consul of the Korean embassy in your country or the consul of your 

country’s embassy in Korea.

C. (If you cannot prepare for A. or B. before the deadline, you may submit the following documents first 

and visit again with A. or B. during the semester.)

   Original copy of degree certificate AND the Letter of Consent(please check the attached file)

   ※ Original copy of degree certificate is returned right after the verification

D. Certificates issued by「China Credentials Verification」 OR 「China Academic Degrees & Graduate 

Education Information」 

   ※ In case of a Chinese degree, it is a mandatory document. Please choose one of the  following methods and submit 

it with your original copy of diploma. Certificates must  be written in English.

    1) China Credentials Verification’s Certificate (http://www.chsi.com/cn)

    2) Credentials Report from China Academic Degrees & Graduate Education Information (http://www.cdgdc.edu.cn)

    3) You can also apply through the official agency in Korea, Confucius Institute in Seoul (http://www.cis.or.kr) 

(02-554-2688)
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Yonsei University Graduate School

  50 Yonsei-ro, Seodaemun-gu, Seoul 03722, Korea 
Graduate School Office (Stimson Hall 2F)

Tel: Seoul Campus / International Campus : 
+82-2-2123-3233

            Fax : +82-2-2123-8652
Mirae Campus : +82-33-760-5032

Email : ysgrad@yonsei.ac.kr
Website : http://graduate.yonsei.ac.kr


